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Q.1

Ans A. 62.56

B. 16.63

C. 99.75

D. 33.25

Question Type : MCQ
Question ID : 441009621055
Option 1 ID : 4410092438354
Option 2 ID : 4410092438352
Option 3 ID : 4410092438355
Option 4 ID : 4410092438353

Status : Not Answered
Chosen Option : --

Q.2 Class intervals and frequencies are given in the following table. If the total frequency is
25, find the median class.
Class Intervals 0-10 10-20 20-30 30-40

Frequency 4 6 10 5

Ans A. 0-10

B. 20-30

C. 10-20

D. 30-40

Question Type : MCQ
Question ID : 4410091822778
Option 1 ID : 4410097185936
Option 2 ID : 4410097185938
Option 3 ID : 4410097185937
Option 4 ID : 4410097185939

Status : Not Answered
Chosen Option : --

Q.3 What sum (in ₹) will earn an interest of ₹480 in 4 years at 5% simple interest per year?

Ans A. 2550

B. 2600

C. 2400

D. 2200

Question Type : MCQ
Question ID : 441009853109
Option 1 ID : 4410093365411
Option 2 ID : 4410093365410
Option 3 ID : 4410093365408
Option 4 ID : 4410093365409

Status : Answered
Chosen Option : C
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Q.4

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009575987
Option 1 ID : 4410092259068
Option 2 ID : 4410092259071
Option 3 ID : 4410092259070
Option 4 ID : 4410092259069

Status : Answered
Chosen Option : A

Q.5 Sam and Tom enter into a partnership. Sam invests ₹30,000 for 6 months, while Tom
invests ₹20,000 for 7 months. For the remaining months of the year, each invests
₹1,000 per month. If the total profit at the end of the year is ₹4,96,500, how much profit
will Sam receive?

Ans A. ₹2,77,000

B. ₹2,79,000

C. ₹2,74,000

D. ₹2,71,000

Question Type : MCQ
Question ID : 441009897160
Option 1 ID : 4410093542713
Option 2 ID : 4410093542710
Option 3 ID : 4410093542711
Option 4 ID : 4410093542712

Status : Not Answered
Chosen Option : --
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Q.6 A man can row 45 kilometers upstream in 5 hours and the same distance downstream
in 3 hours. What is the ratio of the speed of the man in still water to the speed of the
stream?

Ans A. 5 : 2

B. 3 : 1

C. 2 : 1

D. 4 : 1

Question Type : MCQ
Question ID : 4410091453154
Option 1 ID : 4410095740915
Option 2 ID : 4410095740913
Option 3 ID : 4410095740912
Option 4 ID : 4410095740914

Status : Not Answered
Chosen Option : --

Q.7

Ans A. x2 - 14x + 46 = 0

B. x2 + 14x + 46 = 0

C. x2 - 14x + 49 = 0

D. x2 - 14x - 46 = 0

Question Type : MCQ
Question ID : 4410091226534
Option 1 ID : 4410094839622
Option 2 ID : 4410094839620
Option 3 ID : 4410094839621
Option 4 ID : 4410094839619

Status : Not Answered
Chosen Option : --

Q.8 Gopal has two grandsons, Akshay and Atul. 12-year-old Akshay gets some money from
Gopal’s wealth, and 13-year-old Atul gets the rest of the money. But Akshay and Atul
will get the money only when they turn 24 years old. Till then, the money is in a bank
getting interest at the rate of 10% compounded annually. When both turn 24, they
receive the same amount. How much had Gopal given Atul (in ₹) initially, if the total
money with Gopal was ₹25200?10103

Ans A. 13200

B. 11750

C. 12000

D. 13550

Question Type : MCQ
Question ID : 441009573677
Option 1 ID : 4410092249828
Option 2 ID : 4410092249831
Option 3 ID : 4410092249829
Option 4 ID : 4410092249830

Status : Not Answered
Chosen Option : --
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Q.9 Mayank drives the first 200 km in 4 hrs and the next 250 km in next 5 hrs. What is his
average speed for the entire trip (in km/hr)?

Ans A. 55

B. 45

C. 54

D. 50

Question Type : MCQ
Question ID : 441009290955
Option 1 ID : 4410091130692
Option 2 ID : 4410091130694
Option 3 ID : 4410091130691
Option 4 ID : 4410091130693

Status : Answered
Chosen Option : D

Q.1
0

96% of the population of a village is 23,040. The total population of the village is:

Ans A. 32,256

B. 25,640

C. 24,000

D. 24,936

Question Type : MCQ
Question ID : 441009857540
Option 1 ID : 4410093383135
Option 2 ID : 4410093383134
Option 3 ID : 4410093383132
Option 4 ID : 4410093383133

Status : Answered
Chosen Option : C

Q.1
1

Divide ₹1,200 among A, B, and C in the ratio 3 : 4 : 5. Find C’s share.

Ans A. ₹500

B. ₹520

C. ₹450

D. ₹480

Question Type : MCQ
Question ID : 4410091450370
Option 1 ID : 4410095729994
Option 2 ID : 4410095729996
Option 3 ID : 4410095729995
Option 4 ID : 4410095729997

Status : Answered
Chosen Option : A
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Q.1
2

If a manufacturer sells a table to a wholesaler at a gain of 4%, the wholesaler then sells
it to a retailer at a gain of 20%, and finally the retailer sells it to the customer at a gain
of 25%, determine the manufacturing cost (in ₹) of the table given that its final retail
price is ₹85,800.

Ans A. 66,000

B. 57,200

C. 68,750

D. 55,000

Question Type : MCQ
Question ID : 441009895018
Option 1 ID : 4410093534144
Option 2 ID : 4410093534143
Option 3 ID : 4410093534145
Option 4 ID : 4410093534142

Status : Answered
Chosen Option : D

Q.1
3

Consider a number N = 521A3B6. Find the number of ordered pairs (A,B) so that the
number N is divisible by 9.

Ans A. 13

B. 9

C. 10

D. 11

Question Type : MCQ
Question ID : 441009273064
Option 1 ID : 4410091060805
Option 2 ID : 4410091060804
Option 3 ID : 4410091060803
Option 4 ID : 4410091060806

Status : Answered
Chosen Option : C

Q.1
4

Anchal invests her money in a trading company, which claims that it will return four
and half times of the principal in 25 years on a certain rate of simple interest per year.
What is the rate of interest per annnum?

Ans A. 16%

B. 18%

C. 14%

D. 15%

Question Type : MCQ
Question ID : 441009900195
Option 1 ID : 4410093554851
Option 2 ID : 4410093554850
Option 3 ID : 4410093554853
Option 4 ID : 4410093554852

Status : Answered
Chosen Option : B

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


Q.1
5

In an election of two candidates, A and B, candidate A receives 45% of the total votes,
and candidate B receives the remaining votes. If the total number of votes cast is
1,50,000, calculate the difference of number of votes received by each candidate.
1279

Ans A. 20,000

B. 15,000

C. 12,000

D. 18,000

Question Type : MCQ
Question ID : 441009894592
Option 1 ID : 4410093532441
Option 2 ID : 4410093532439
Option 3 ID : 4410093532440
Option 4 ID : 4410093532438

Status : Answered
Chosen Option : B

Q.1
6

Pipe A can fill an empty cistern alone in 4 hours and pipe B can fill the same cistern
alone in 4 hours. The time taken (in hours) by them to fill half of the cistern by
operating together will be:4018

Ans A. 1

B. 4

C. 3

D. 2

Question Type : MCQ
Question ID : 441009897331
Option 1 ID : 4410093543394
Option 2 ID : 4410093543397
Option 3 ID : 4410093543396
Option 4 ID : 4410093543395

Status : Answered
Chosen Option : D

Q.1
7

The running cost of a truck is directly proportional to its fuel prices and the fare
charged by the owner of the truck is directly proportional to running cost. When the
fuel price is ₹80 per unit, the fare is ₹2,500 per km. When the running cost is ₹1,200 per
km, the fuel price is ₹60. What is the fare in ₹ per km when the running cost is ₹2,500
per km?

Ans A. 3,096.25

B. 3,609.25

C. 3,906.25

D. 3,069.25

Question Type : MCQ
Question ID : 4410091456200
Option 1 ID : 4410095753148
Option 2 ID : 4410095753147
Option 3 ID : 4410095753146
Option 4 ID : 4410095753149

Status : Not Answered
Chosen Option : --
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Q.1
8

Peter purchased a car listed at ₹205000 at a discount of 8%. If sales tax is charged at
the rate of 12% on the discounted price, find the amount Peter had paid for purchasing
the car.

Ans A. ₹211232

B. ₹411202

C. ₹211245

D. ₹115232

Question Type : MCQ
Question ID : 4410091605584
Option 1 ID : 4410096341394
Option 2 ID : 4410096341396
Option 3 ID : 4410096341395
Option 4 ID : 4410096341397

Status : Answered
Chosen Option : A

Q.1
9

The volume of a spherical ball is 904.32 cm3. What is its diameter (in centimeters, use π
= 3.14)?

Ans A. 8

B. 12

C. 10

D. 6

Question Type : MCQ
Question ID : 441009276563
Option 1 ID : 4410091074382
Option 2 ID : 4410091074384
Option 3 ID : 4410091074383
Option 4 ID : 4410091074381

Status : Not Answered
Chosen Option : --

Q.2
0

A pipe can fill a tank in 15 minutes, but a leak at the bottom can empty it in 20 minutes.
If both are opened, how long will it take to fill 75% of the tank?

Ans A. 42 min

B. 36 min

C. 30 min

D. 45 min

Question Type : MCQ
Question ID : 441009193696
Option 1 ID : 441009762905
Option 2 ID : 441009762904
Option 3 ID : 441009762903
Option 4 ID : 441009762906

Status : Answered
Chosen Option : D

Section : General Studies
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Q.2
1

Which of the following is a north-bank tributary of the Brahmaputra that originates in
Tibet and flows through Arunachal Pradesh?

Ans A. Subansiri

B. Teesta

C. Manas

D. Dhansiri

Question Type : MCQ
Question ID : 441009998806
Option 1 ID : 4410093947078
Option 2 ID : 4410093947077
Option 3 ID : 4410093947079
Option 4 ID : 4410093947080

Status : Answered
Chosen Option : B

Q.2
2

According to Census 2011, Kurung Kumey district of which state registered the highest
population growth rate of 111.01%?

Ans A. Mizoram

B. Arunachal Pradesh

C. Assam

D. Manipur

Question Type : MCQ
Question ID : 441009866846
Option 1 ID : 4410093420419
Option 2 ID : 4410093420418
Option 3 ID : 4410093420416
Option 4 ID : 4410093420417

Status : Answered
Chosen Option : C

Q.2
3

Who is known as “Utkal Gourav” and played a key role in the unification of Odia-
speaking regions?

Ans A. Nilakantha Das

B. Fakir Mohan Senapati

C. Madhusudan Das

D. Gopabandhu Das

Question Type : MCQ
Question ID : 4410091847742
Option 1 ID : 4410097283287
Option 2 ID : 4410097283286
Option 3 ID : 4410097283284
Option 4 ID : 4410097283285

Status : Answered
Chosen Option : C

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


Q.2
4

What are the primary climate characteristics of the East and South Eastern Coastal
Plain agro-climatic zone in Odisha?

Ans A. Freezing

B. Hot and humid

C. Cold and arid

D. Mild and dry

Question Type : MCQ
Question ID : 441009646064
Option 1 ID : 4410092538374
Option 2 ID : 4410092538372
Option 3 ID : 4410092538371
Option 4 ID : 4410092538373

Status : Not Answered
Chosen Option : --

Q.2
5

In February 2026, the Government of India launched the Resilience and Logistic
Intervention for Export Promotion (RELIEF) scheme to support exporters affected by
disruptions caused by which region?

Ans A. Central Asia

B. West Asia

C. Southeast Asia

D. East Africa

Question Type : MCQ
Question ID : 4410091854856
Option 1 ID : 4410097310674
Option 2 ID : 4410097310673
Option 3 ID : 4410097310672
Option 4 ID : 4410097310675

Status : Answered
Chosen Option : A

Q.2
6

Which of the following objectives is associated with the Jal Jeevan Mission?

Ans A. Supplying industrial water to manufacturing units

B. Ensuring household tap water connections in rural areas

C. Developing desalination plants for cities

D. Providing irrigation water for agricultural fields

Question Type : MCQ
Question ID : 441009869123
Option 1 ID : 4410093429525
Option 2 ID : 4410093429524
Option 3 ID : 4410093429526
Option 4 ID : 4410093429523

Status : Answered
Chosen Option : B
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Q.2
7

Which of the following ideas is NOT explicitly mentioned in the Preamble?

Ans A. Economic prosperity — through planned development

B. Equality — of status and of opportunity

C. Justice — social, economic, and political

D. Liberty — of thought, expression, belief, faith, and worship

Question Type : MCQ
Question ID : 4410091443559
Option 1 ID : 4410095702773
Option 2 ID : 4410095702772
Option 3 ID : 4410095702770
Option 4 ID : 4410095702771

Status : Answered
Chosen Option : A

Q.2
8

Why are lysosomes often called the “suicidal bags” of the cell?

Ans A. They help in protein synthesis

B. They can destroy the cell

C. They digest nutrients

D. They are responsible for cell division

Question Type : MCQ
Question ID : 4410091432208
Option 1 ID : 4410095657166
Option 2 ID : 4410095657168
Option 3 ID : 4410095657167
Option 4 ID : 4410095657169

Status : Answered
Chosen Option : B

Q.2
9

A company failed to implement appropriate safeguards for protecting personal data it
holds. According to the Digital Personal Data Protection Act, 2023, as per rules notified
on 14 November 2025, what is the maximum financial penalty that can be imposed for
this specific failure?

Ans A. Up to ₹100 crore

B. Up to ₹200 crore

C. Up to ₹50 crore

D. Up to ₹250 crore

Question Type : MCQ
Question ID : 4410091832188
Option 1 ID : 4410097222778
Option 2 ID : 4410097222781
Option 3 ID : 4410097222780
Option 4 ID : 4410097222779

Status : Not Answered
Chosen Option : --
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Q.3
0

Why did Netaji Subhas Chandra Bose call Vivekananda the creator of modern India?

Ans A. Due to his military strategies

B. For his role in spiritual and national awakening

C. Because of his political activism

D. Because he founded the Indian National Congress

Question Type : MCQ
Question ID : 4410091068699
Option 1 ID : 4410094220297
Option 2 ID : 4410094220298
Option 3 ID : 4410094220296
Option 4 ID : 4410094220299

Status : Answered
Chosen Option : A

Q.3
1

Where is Pari Mahal, or the Angels’ Abode, located?

Ans A. Gandhinagar

B. Srinagar

C. Bhubaneswar

D. Chandigarh

Question Type : MCQ
Question ID : 441009893052
Option 1 ID : 4410093526278
Option 2 ID : 4410093526280
Option 3 ID : 4410093526281
Option 4 ID : 4410093526279

Status : Answered
Chosen Option : A

Q.3
2

The shortest path between the starting point and the ending point of an object’s motion
is called _____________.

Ans A. Speed

B. Displacement

C. Distance

D. Velocity

Question Type : MCQ
Question ID : 4410091445143
Option 1 ID : 4410095709154
Option 2 ID : 4410095709155
Option 3 ID : 4410095709153
Option 4 ID : 4410095709156

Status : Answered
Chosen Option : B
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Q.3
3

Who among the following was conferred the Major Dhyan Chand Khel Ratna Award
2024 in Chess?

Ans A. D. Gukesh

B. Praggnanandhaa R

C. Vantika Agrawal

D. Viswanathan Anand

Question Type : MCQ
Question ID : 4410091578608
Option 1 ID : 4410096235518
Option 2 ID : 4410096235517
Option 3 ID : 4410096235519
Option 4 ID : 4410096235516

Status : Answered
Chosen Option : A

Q.3
4

On July 17, 2025, the missile‐testing range at Chandipur in Odisha was used for the
test‐firing of which pair of missiles?

Ans A. BrahMos & Nirbhay

B. Agni-2 & Agni-3

C. Agni-5 & Prithvi-III

D. Prithvi-II & Agni-1

Question Type : MCQ
Question ID : 4410091472567
Option 1 ID : 4410095818139
Option 2 ID : 4410095818140
Option 3 ID : 4410095818137
Option 4 ID : 4410095818138

Status : Not Answered
Chosen Option : --

Q.3
5

Which of the following international organisations published the Human Development
Report 2025 as part of its annual global release?

Ans A. United Nations Industrial Development Organization (UNIDO)

B. United Nations Educational, Scientific and Cultural Organization (UNESCO)

C. United Nations Development Programme (UNDP)

D. United Nations Environment Programme (UNEP)

Question Type : MCQ
Question ID : 4410091543680
Option 1 ID : 4410096097781
Option 2 ID : 4410096097780
Option 3 ID : 4410096097778
Option 4 ID : 4410096097779

Status : Answered
Chosen Option : C
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Q.3
6

In September 2025, para-badminton player Pramod Bhagat won a gold medal in which
event?

Ans A. Indonesia Para Badminton Open 2025 (Men’s singles SL3)

B. Abia Para Badminton International 2025 (Men’s men’s doubles SL3–SU5)

C. China Para Badminton International 2025 (Men’s singles SL3)

D. European Para Badminton Championship 2025 (Mixed doubles SL3–SU5)

Question Type : MCQ
Question ID : 4410091535257
Option 1 ID : 4410096064285
Option 2 ID : 4410096064284
Option 3 ID : 4410096064283
Option 4 ID : 4410096064286

Status : Not Answered
Chosen Option : --

Q.3
7

What distinguishes the Fundamental Rights from the Directive Principles of State
Policy?

Ans A. Directive Principles prioritise individual rights, whereas Fundamental Rights focus on
state policies.

B. Fundamental Rights are enforceable in a court of law, whereas Directive Principles
are not.

C. Directive Principles are justiciable, while Fundamental Rights are not.

D. Both Fundamental Rights and Directive Principles are enforceable in court.

Question Type : MCQ
Question ID : 441009501463
Option 1 ID : 4410091961023
Option 2 ID : 4410091961022
Option 3 ID : 4410091961025
Option 4 ID : 4410091961024

Status : Answered
Chosen Option : B

Q.3
8

What title was given to Bahadur Shah II by the mutineers?

Ans A. Nawab-e-Hind

B. Nawab-e-Dilli

C. Shahenshah-e-Hind

D. Shahenshah-e-Dilli

Question Type : MCQ
Question ID : 441009862363
Option 1 ID : 4410093402574
Option 2 ID : 4410093402576
Option 3 ID : 4410093402577
Option 4 ID : 4410093402575

Status : Answered
Chosen Option : D
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Q.3
9

The 61st Amendment to the Indian Constitution is notable for its impact on democratic
participation. Which specific change did it introduce?

Ans A. Lowering the minimum voting age from 21 to 18 years

B. Expanding reservation quotas in jobs and education

C. Introducing anti-defection provisions for legislators

D. Establishing Panchayati Raj institutions

Question Type : MCQ
Question ID : 4410091842335
Option 1 ID : 4410097262354
Option 2 ID : 4410097262353
Option 3 ID : 4410097262355
Option 4 ID : 4410097262356

Status : Answered
Chosen Option : A

Q.4
0

1937 ମସିହା ଅପ୍ରେଲ 1 ତାରିଖରେ, ଓଡ଼ିଶାର ରାଜ୍ୟପାଳ ସାର ଜନ ଅଷ୍ଟିନ ହବାକ (Sir John Austin
Hubback) ଙ୍କ ନିମନ୍ତ୍ରଣ କ୍ରମେ, ପ୍ରାଦେଶିକ ସଭା (Provincial Assembly) କୁ ନିର୍ବାଚିତ ହୋଇ କିଏ ମନ୍ତ୍ରୀମଣ୍ଡଳ
ଗଠନ କରିଥିଲେ ଏବଂ ଏହିପରି ଭାବେ ଓଡ଼ିଶାର ପ୍ରଥମ 'ପ୍ରଧାନମନ୍ତ୍ରୀ' ହୋଇଥିଲେ?

Ans A. ବିଜୁ ପଟ୍ଟନାୟକ

B. ଦିଲୀପ ରାୟ

C. କୃଷ୍ଣ ଚନ୍ଦ୍ର ଗଜପତି

D. ମଧୁସୂଦନ ଦାସ

Question Type : MCQ
Question ID : 4410091424236
Option 1 ID : 4410095625759
Option 2 ID : 4410095625762
Option 3 ID : 4410095625760
Option 4 ID : 4410095625761

Status : Not Answered
Chosen Option : --

Q.4
1

Which of the following regions is a major area of the evergreen rainforest biome?

Ans A. Amazon Basin located in northern South American region

B. Sahara Desert located in northern African region

C. Gobi Desert located in central Asian region

D. Great Plains located in central North American region

Question Type : MCQ
Question ID : 4410091843728
Option 1 ID : 4410097267853
Option 2 ID : 4410097267854
Option 3 ID : 4410097267855
Option 4 ID : 4410097267856

Status : Not Answered
Chosen Option : --
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Q.4
2

Decomposition reaction accompanied by heating is known as _______________.

Ans A. Double displacement reaction

B. Displacement reaction

C. Thermal decomposition

D. Exothermic reaction

Question Type : MCQ
Question ID : 4410091432189
Option 1 ID : 4410095657083
Option 2 ID : 4410095657082
Option 3 ID : 4410095657085
Option 4 ID : 4410095657084

Status : Answered
Chosen Option : D

Q.4
3

The International Rail Coach Expo (IRCE) 2026 was inaugurated at which location?

Ans A. Integral Coach Factory, Chennai

B. Rail Coach Factory, Kapurthala

C. Modern Coach Factory, Raebareli

D. Diesel Locomotive Works, Varanasi

Question Type : MCQ
Question ID : 4410091855757
Option 1 ID : 4410097314148
Option 2 ID : 4410097314147
Option 3 ID : 4410097314150
Option 4 ID : 4410097314149

Status : Not Answered
Chosen Option : --

Q.4
4

"Zero Hunger” and “Climate Action” are related to which Sustainable Development
Goals (SDGs)?

Ans A. SDG 3 and SDG 14

B. SDG 4 and SDG 15

C. SDG 1 and SDG 12

D. SDG 2 and SDG 13

Question Type : MCQ
Question ID : 4410091437956
Option 1 ID : 4410095680527
Option 2 ID : 4410095680528
Option 3 ID : 4410095680525
Option 4 ID : 4410095680526

Status : Not Answered
Chosen Option : --
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Q.4
5

Which of these rivers is listed as originating from the eastern slopes of the Eastern
Ghats?

Ans A. Mahanadi

B. Samolia

C. Brahmani

D. Rushikulya

Question Type : MCQ
Question ID : 4410091424513
Option 1 ID : 4410095626905
Option 2 ID : 4410095626903
Option 3 ID : 4410095626906
Option 4 ID : 4410095626904

Status : Not Answered
Chosen Option : --

Q.4
6

Select the option that identifies an error in the sentence and provides its correct
replacement.

Actors first understand the character, then memorize their lines, rehearse with proper
expressions to submerge themselves in the role, and finally perform on stage.

Ans A. Replace “memorize their lines” with “finish their lines”

B. Replace “submerge themselves in the role” with “immerse themselves in the role”

C. Replace “first understand the character” with “first estimate the character”

D. Replace “finally perform on stage” with “finally performing on stage”

Question Type : MCQ
Question ID : 4410091830422
Option 1 ID : 4410097215668
Option 2 ID : 4410097215669
Option 3 ID : 4410097215667
Option 4 ID : 4410097215670

Status : Answered
Chosen Option : B

Q.4
7

Identify the segment of the sentence that contains a grammatical error.

After spotting the mouse, the cat endlessly came out from the couch and waited
patiently, then suddenly pounced but unfortunately missed her prey.

Ans A. then suddenly pounced

B. the couch and waited patiently

C. the cat endlessly came out from

D. but unfortunately missed her prey

Question Type : MCQ
Question ID : 4410091827860
Option 1 ID : 4410097205614
Option 2 ID : 4410097205613
Option 3 ID : 4410097205612
Option 4 ID : 4410097205615

Status : Answered
Chosen Option : C

Section : English
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Q.4
8

Choose the correct form of future perfect tense.

Ans A. By 2026, they will be completing the new bridge.

B. By 2026, they will complete the new bridge.

C. By 2026, they will have completed the new bridge.

D. By 2026, they will have been completing the new bridge.

Question Type : MCQ
Question ID : 4410091824379
Option 1 ID : 4410097192105
Option 2 ID : 4410097192104
Option 3 ID : 4410097192103
Option 4 ID : 4410097192106

Status : Answered
Chosen Option : C

Q.4
9

Identify the part of the sentence that contains an error.

Each of the students have submitted their assignments on time despite facing several
difficulties during the project.

Ans A. their assignments on time

B. during the project

C. despite facing several difficulties

D. Each of the students have submitted

Question Type : MCQ
Question ID : 4410091825573
Option 1 ID : 4410097196592
Option 2 ID : 4410097196594
Option 3 ID : 4410097196593
Option 4 ID : 4410097196591

Status : Answered
Chosen Option : D

Q.5
0

Which option best replaces the underlined words in the sentence?
The museum was developed with the help of wealthy supporters of ancient art.

Ans A. pilgrims

B. patrons

C. partners

D. pedestrians

Question Type : MCQ
Question ID : 4410091830321
Option 1 ID : 4410097215273
Option 2 ID : 4410097215271
Option 3 ID : 4410097215274
Option 4 ID : 4410097215272

Status : Answered
Chosen Option : B
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Q.5
1

Choose the incorrect sentence in passive voice.

Ans A. The match is being watched by thousands of spectators.

B. The novel was written by a renowned author.

C. The results have announced by the authorities yesterday.

D. The instructions were followed carefully by the participants.

Question Type : MCQ
Question ID : 4410091825595
Option 1 ID : 4410097196676
Option 2 ID : 4410097196678
Option 3 ID : 4410097196677
Option 4 ID : 4410097196675

Status : Answered
Chosen Option : C

Q.5
2

Choose the most appropriate one-word substitute for the words in bold.

The hero’s tragic end in the crime thriller revealed his fear of confined spaces.

Ans A. agoraphobia

B. xenophobia

C. claustrophobia

D. acrophobia

Question Type : MCQ
Question ID : 4410091800185
Option 1 ID : 4410097097815
Option 2 ID : 4410097097816
Option 3 ID : 4410097097814
Option 4 ID : 4410097097817

Status : Answered
Chosen Option : C

Q.5
3

Rearrange the following parts to form a coherent and grammatically correct sentence.

A. whispering secrets
B. the old mansion
C. to the wind
D. stood alone on the hill,
E. surrounded by wild flowers

Ans A. D – B – E – A – C

B. E – B – D – A – C

C. B – E – D – A – C

D. B – D – E – A – C

Question Type : MCQ
Question ID : 4410091818490
Option 1 ID : 4410097169311
Option 2 ID : 4410097169313
Option 3 ID : 4410097169312
Option 4 ID : 4410097169310

Status : Answered
Chosen Option : A
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Q.5
4

Identify the meaning of the given idiom.

Cross the Rubicon

Ans A. To take an irreversible step from which there is no turning back

B. To overcome a challenging task with great skill and certainty

C. To hesitate before making an important decision or commitment

D. To consider different alternatives before taking the final action

Question Type : MCQ
Question ID : 441009411494
Option 1 ID : 4410091611366
Option 2 ID : 4410091611367
Option 3 ID : 4410091611368
Option 4 ID : 4410091611369

Status : Answered
Chosen Option : A

Q.5
5

Identify the segment containing an error in the given sentence.

(A) The delegate had scarcely / (B) begun the address than / (C) the panel raised
serious / (D) objections to every claim

Ans A. begun the address than

B. The delegate had scarcely

C. objections to every claim

D. the panel raised serious

Question Type : MCQ
Question ID : 4410091848468
Option 1 ID : 4410097286134
Option 2 ID : 4410097286133
Option 3 ID : 4410097286136
Option 4 ID : 4410097286135

Status : Not Answered
Chosen Option : --

Q.5
6

Complete the indirect sentence for the given direct speech sentence by choosing the
correct option.

Direct: She said to me, 'Have you finished your homework?'
Indirect: She asked me _________.

Ans A. if I had finished my homework

B. if I have finished my homework

C. whether had I finished my homework

D. that I had finished my homework

Question Type : MCQ
Question ID : 4410091832535
Option 1 ID : 4410097224151
Option 2 ID : 4410097224149
Option 3 ID : 4410097224152
Option 4 ID : 4410097224150

Status : Answered
Chosen Option : A
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Q.5
7

Select the correct meaning of the idiom that can replace the underlined words.

The board decided not to sweep the issue under the carpet and ordered a full
investigation.

Ans A. exaggerate the problem

B. discuss the matter openly

C. hide the problem deliberately

D. delay taking responsibility

Question Type : MCQ
Question ID : 4410091566458
Option 1 ID : 4410096187236
Option 2 ID : 4410096187239
Option 3 ID : 4410096187238
Option 4 ID : 4410096187237

Status : Answered
Chosen Option : B

Q.5
8

Choose the correct antonym of the underlined word to complete the sentence.
The man was dubious about the facts presented in the case, unlike the judge, who was
__________ about the evidence.

Ans A. unusual

B. certain

C. reliable

D. skeptical

Question Type : MCQ
Question ID : 4410091829239
Option 1 ID : 4410097211083
Option 2 ID : 4410097211084
Option 3 ID : 4410097211082
Option 4 ID : 4410097211081

Status : Answered
Chosen Option : B

Q.5
9

Out of the four alternatives, choose the one that can be used as a substitute for the
bracketed word segment.

A/An (person or animal that eats the flesh of its own species) is extremely rare in
modern human societies.

Ans A. omnivore

B. scavenger

C. cannibal

D. predator

Question Type : MCQ
Question ID : 4410091831528
Option 1 ID : 4410097220012
Option 2 ID : 4410097220014
Option 3 ID : 4410097220011
Option 4 ID : 4410097220013

Status : Answered
Chosen Option : C
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Q.6
0

Complete the sentence with the correct synonym of the underlined word.

The intrepid reporter revealed the truth without concern for the consequences, as he
was completely __________.

Ans A. fearless

B. anxious

C. hostile

D. energetic

Question Type : MCQ
Question ID : 4410091832835
Option 1 ID : 4410097225337
Option 2 ID : 4410097225340
Option 3 ID : 4410097225339
Option 4 ID : 4410097225338

Status : Answered
Chosen Option : A

Comprehension:

Read the given passage and answer the questions that follow.

Time management is the ability to organise and use time effectively to complete tasks and
achieve goals. In today’s fast-paced world, students and professionals often have many
responsibilities. Without proper planning, people may feel stressed and unable to finish their
work on time.

Good time management helps individuals decide which tasks are most important and how
much time should be given to each activity. Students who plan their study schedule carefully
can complete assignments on time and prepare better for examinations. Managing time well
also allows people to balance work, rest, and personal activities.

On the other hand, poor time management can lead to missed deadlines and unnecessary
pressure. People who delay their work may struggle to complete tasks efficiently. Therefore,
developing good time management habits is essential for improving productivity and
maintaining a balanced and organised life.

SubQuestion No : 61

Q.6
1

What does good time management help individuals do?

Ans A. Focus only on personal interests

B. Ignore less important tasks completely

C. Decide which tasks are most important

D. Reduce the number of daily activities

Question Type : MCQ
Question ID : 4410091823029
Option 1 ID : 4410097186935
Option 2 ID : 4410097186932
Option 3 ID : 4410097186933
Option 4 ID : 4410097186934

Status : Answered
Chosen Option : C
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Comprehension:

Read the given passage and answer the questions that follow.

Time management is the ability to organise and use time effectively to complete tasks and
achieve goals. In today’s fast-paced world, students and professionals often have many
responsibilities. Without proper planning, people may feel stressed and unable to finish their
work on time.

Good time management helps individuals decide which tasks are most important and how
much time should be given to each activity. Students who plan their study schedule carefully
can complete assignments on time and prepare better for examinations. Managing time well
also allows people to balance work, rest, and personal activities.

On the other hand, poor time management can lead to missed deadlines and unnecessary
pressure. People who delay their work may struggle to complete tasks efficiently. Therefore,
developing good time management habits is essential for improving productivity and
maintaining a balanced and organised life.

SubQuestion No : 62

Q.6
2

What can be inferred from the passage about poor time management?

Ans A. It may create pressure and missed deadlines.

B. It helps people complete tasks more quickly.

C. It strengthens people’s decision-making skills.

D. It improves productivity in difficult situations.

Question Type : MCQ
Question ID : 4410091823030
Option 1 ID : 4410097186938
Option 2 ID : 4410097186936
Option 3 ID : 4410097186939
Option 4 ID : 4410097186937

Status : Answered
Chosen Option : A
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Comprehension:

Read the given passage and answer the questions that follow.

Time management is the ability to organise and use time effectively to complete tasks and
achieve goals. In today’s fast-paced world, students and professionals often have many
responsibilities. Without proper planning, people may feel stressed and unable to finish their
work on time.

Good time management helps individuals decide which tasks are most important and how
much time should be given to each activity. Students who plan their study schedule carefully
can complete assignments on time and prepare better for examinations. Managing time well
also allows people to balance work, rest, and personal activities.

On the other hand, poor time management can lead to missed deadlines and unnecessary
pressure. People who delay their work may struggle to complete tasks efficiently. Therefore,
developing good time management habits is essential for improving productivity and
maintaining a balanced and organised life.

SubQuestion No : 63

Q.6
3

Which of the following is the most appropriate title for the passage?

Ans A. The Effects of Stress on Students

B. The Growth of Academic Competition

C. The Importance of Time Management

D. The Development of Personal Discipline

Question Type : MCQ
Question ID : 4410091823031
Option 1 ID : 4410097186943
Option 2 ID : 4410097186941
Option 3 ID : 4410097186940
Option 4 ID : 4410097186942

Status : Answered
Chosen Option : C
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Comprehension:

Read the given passage and answer the questions that follow.

Time management is the ability to organise and use time effectively to complete tasks and
achieve goals. In today’s fast-paced world, students and professionals often have many
responsibilities. Without proper planning, people may feel stressed and unable to finish their
work on time.

Good time management helps individuals decide which tasks are most important and how
much time should be given to each activity. Students who plan their study schedule carefully
can complete assignments on time and prepare better for examinations. Managing time well
also allows people to balance work, rest, and personal activities.

On the other hand, poor time management can lead to missed deadlines and unnecessary
pressure. People who delay their work may struggle to complete tasks efficiently. Therefore,
developing good time management habits is essential for improving productivity and
maintaining a balanced and organised life.

SubQuestion No : 64

Q.6
4

Which of the following is the antonym of the word balanced as used in the passage?

Ans A. Controlled

B. Organised

C. Stable

D. Uneven

Question Type : MCQ
Question ID : 4410091823032
Option 1 ID : 4410097186947
Option 2 ID : 4410097186944
Option 3 ID : 4410097186945
Option 4 ID : 4410097186946

Status : Answered
Chosen Option : C
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Comprehension:

Read the given passage and answer the questions that follow.

Time management is the ability to organise and use time effectively to complete tasks and
achieve goals. In today’s fast-paced world, students and professionals often have many
responsibilities. Without proper planning, people may feel stressed and unable to finish their
work on time.

Good time management helps individuals decide which tasks are most important and how
much time should be given to each activity. Students who plan their study schedule carefully
can complete assignments on time and prepare better for examinations. Managing time well
also allows people to balance work, rest, and personal activities.

On the other hand, poor time management can lead to missed deadlines and unnecessary
pressure. People who delay their work may struggle to complete tasks efficiently. Therefore,
developing good time management habits is essential for improving productivity and
maintaining a balanced and organised life.

SubQuestion No : 65

Q.6
5

What is the author’s tone in the passage?

Ans A. Entertaining

B. Emotional

C. Argumentative

D. Informative

Question Type : MCQ
Question ID : 4410091823033
Option 1 ID : 4410097186950
Option 2 ID : 4410097186949
Option 3 ID : 4410097186951
Option 4 ID : 4410097186948

Status : Answered
Chosen Option : D

Q.6
6

“ଯବ” ର ତଦ୍ଭବ ରୂ ପ କ'ଣ?

Ans A. ଯଅ

B. ବାଜରା

C. ବାଉଁ ଶ

D. ମକା

Question Type : MCQ
Question ID : 4410091235951
Option 1 ID : 4410094877392
Option 2 ID : 4410094877390
Option 3 ID : 4410094877391
Option 4 ID : 4410094877393

Status : Answered
Chosen Option : A

Section : Odia
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Q.6
7

ମୁଁ  ଏକ ______ ଛତା କିଣିଛି।

Ans A. ନୀଳତମ

B. ନୀଳତ୍ଵ

C. ନୀଳ

D. ନୀଳତା

Question Type : MCQ
Question ID : 4410091675879
Option 1 ID : 4410096612350
Option 2 ID : 4410096612351
Option 3 ID : 4410096612348
Option 4 ID : 4410096612349

Status : Answered
Chosen Option : C

Q.6
8

ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ବିପରୀତ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ
ଜଙ୍ଗମ

Ans A. ସ୍ଥାବର

B. ଜଙ୍ଗଲ

C. ସମ୍ପତ୍ତି

D. ଧନ

Question Type : MCQ
Question ID : 4410091676074
Option 1 ID : 4410096613118
Option 2 ID : 4410096613116
Option 3 ID : 4410096613117
Option 4 ID : 4410096613119

Status : Answered
Chosen Option : A

Q.6
9

ଦିଆଯାଇଥିବା ଓଡ଼ିଆ ବାକ୍ୟର ସବୁଠାରୁ  ଉପଯୁକ୍ତ ଇଂରାଜୀ ଅନୁବାଦ ବିକଳ୍ପ ବାଛନ୍ତୁ।

ଓଡ଼ିଶାର ପ୍ରତିଟି ଗାଁ ରେ ପକ୍କା ଘର ହେବାରୁ  ଗ୍ରାମବାସୀ ବହୁତ ଖୁସି ଅଛନ୍ତି।

Ans A. The villagers are very happy because every village has a pucca house.

B. The villagers will be very happy to have a pucca house in every village in Odisha.

C. The villagers are very happy to have a pucca house in every village in Odisha.

D. The villagers were very happy to have a pucca house in every village in Odisha.

Question Type : MCQ
Question ID : 4410091232556
Option 1 ID : 4410094863940
Option 2 ID : 4410094863942
Option 3 ID : 4410094863941
Option 4 ID : 4410094863943

Status : Answered
Chosen Option : C
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Q.7
0

ସେ ଇଂରାଜୀ ______ ହିନ୍ଦୀ ଅନର୍ଗଳ ଭାବରେ କହିପାରନ୍ତି।

Ans A. କିନ୍ତୁ

B. ତେଣୁ

C. ଏବଂ

D. କିମ୍ବା

Question Type : MCQ
Question ID : 4410091675426
Option 1 ID : 4410096610846
Option 2 ID : 4410096610847
Option 3 ID : 4410096610845
Option 4 ID : 4410096610844

Status : Answered
Chosen Option : A

Q.7
1

ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ବିପରୀତ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ
ଶାନ୍ତ

Ans A. ଉଗ୍ର

B. ସ୍ଵଭାବ

C. ଉଦାର

D. ନମ୍ର

Question Type : MCQ
Question ID : 4410091676023
Option 1 ID : 4410096612914
Option 2 ID : 4410096612912
Option 3 ID : 4410096612913
Option 4 ID : 4410096612915

Status : Answered
Chosen Option : A

Q.7
2

ଦିଆଯାଇଥିବା ଇଂରାଜୀ ବାକ୍ୟକୁ ଓଡ଼ିଆରେ ଅନୁବାଦ କର।

Everymorning I watch DD news with a cup of tea.

Ans A. ମୁଁ  ପ୍ରତିଦିନ ସକାଳେ ଡିଡି ନ୍ୟୁଜ୍ ଦେଖେ।

B. ମୁଁ  ପ୍ରତିଦିନ ଚା’ ପିଇବା ସମୟରେ ଡିଡି ନ୍ୟୁଜ୍ ଦେଖି ବି।

C. ମୁଁ  ପ୍ରତିଦିନ ସକାଳେ ଚା ପିଇବା ସମୟରେ ଡିଡି ନ୍ୟୁଜ୍ ଦେଖୁଥି ଲି।

D. ମୁଁ  ପ୍ରତିଦିନ ସକାଳେ ଚା’ ପିଇବା ସମୟରେ ଡିଡି ନ୍ୟୁଜ୍ ଦେଖେ।

Question Type : MCQ
Question ID : 4410091235122
Option 1 ID : 4410094874225
Option 2 ID : 4410094874223
Option 3 ID : 4410094874224
Option 4 ID : 4410094874222

Status : Answered
Chosen Option : D
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Q.7
3

ଦିଆଯାଇଥିବା ଓଡ଼ିଆ ବାକ୍ୟର ସବୁଠାରୁ  ଉପଯୁକ୍ତ ଇଂରାଜୀ ଅନୁବାଦ ବିକଳ୍ପ ବାଛନ୍ତୁ।
ଆମେ ସର୍ବଦା ଅନ୍ୟମାନଙ୍କୁ ସାହାଯ୍ୟ କରିବା ଆବଶ୍ୟକ।

Ans A. We may always help others.

B. We always help others.

C. We should always help others.

D. We would always help others.

Question Type : MCQ
Question ID : 4410091230770
Option 1 ID : 4410094856566
Option 2 ID : 4410094856569
Option 3 ID : 4410094856568
Option 4 ID : 4410094856567

Status : Answered
Chosen Option : C

Q.7
4

ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ବିପରୀତ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ
ଉକ୍ତ

Ans A. ଅନୁକ୍ତ

B. ଶବ୍ଦ

C. ବାକ୍ୟ

D. ଶୀର୍ଷ

Question Type : MCQ
Question ID : 4410091676009
Option 1 ID : 4410096612856
Option 2 ID : 4410096612859
Option 3 ID : 4410096612857
Option 4 ID : 4410096612858

Status : Not Answered
Chosen Option : --

Q.7
5

ଆମେ ରାତ୍ରୀଭୋଜନ କରୁ ଥିଲାବେଳେ ଫୋନ ଘଣ୍ଟି ______।

Ans A. ବାଜୁଛି

B. ବାଜିଲା

C. ବାଜିବ

D. ବାଜିଛି

Question Type : MCQ
Question ID : 4410091675541
Option 1 ID : 4410096611151
Option 2 ID : 4410096611150
Option 3 ID : 4410096611149
Option 4 ID : 4410096611148

Status : Answered
Chosen Option : B
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Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

ମା'–ବାପା ହେଉଛନ୍ତି ଆମ ଜୀବନର ପ୍ରଥମ ଶିକ୍ଷକ ଓ ଅଧ୍ୟାପକ। ସେମାନେ ଆମକୁ କେବଳ ଜନ୍ମ  ଦେଇନାହାନ୍ତି, ବରଂ ଆମକୁ
ଭଲ ମଣିଷ ହେବା ଶିଖାନ୍ତି। ମା' ଆମକୁ ସ୍ନେହ, ମମତା ଓ ସେବା ଦିଅନ୍ତି, ଯେବେକି ବାପା ଆମ ପାଇଁ  ସର୍ବଦା ପରିଶ୍ରମ କରନ୍ତି।

ଯେପରି ଗଛ ତାହାର ମୂଳ ଦ୍ୱାରା ଦୃଢ ହୁଏ, ତେଣୁ ଶିଶୁ ମା'–ବାପାଙ୍କ ଶିକ୍ଷା ଓ ଆଦର୍ଶ ଦ୍ୱାରା ସୁସଂସ୍କାରିତ ହୁଏ। ଯେ ଶିଶୁ
ମା'–ବାପାଙ୍କ କଥା ଶୁଣେ, ସେ ଜୀବନରେ ସଫଳ ହୁଏ। ଯେ ମା'–ବାପାଙ୍କୁ ସମ୍ମାନ କରେନି, ସେ ନିଜ ଜୀବନର ସତ୍ୟ
ମୂଲ୍ୟକୁ ହାରାଏ।

ମା'–ବାପା ଆମ ଜୀବନର ଦିଗଦର୍ଶକ ଓ ସହାୟକ। ସେମାନଙ୍କ ସନ୍ତୁଷ୍ଟି  ହେଉଛି ଆମ ସଫଳତା। ତେଣୁ ପ୍ରତ୍ୟେକ ସନ୍ତାନଙ୍କୁ
ମା'–ବାପାଙ୍କ ଶୁଶ୍ରୁ ଷା କରିବା ଓ ସେମାନଙ୍କ ଆଦେଶ ମାନିବା ଉଚିତ।

SubQuestion No : 76

Q.7
6

ଅନୁଚ୍ଛେଦପାଇଁ  ସଠିକ ସାରାଂଶ ଚୟନ କର।

Ans A. ସନ୍ତାନ ମା'–ବାପାଙ୍କୁ ଶୁଣିଲେ ସଫଳ ହୁଏ।

B. ମା'–ବାପା ଆମକୁ ଶିଖାନ୍ତି କିପରି ଭଲ ମଣିଷ ହେବା।

C. ମା'–ବାପାଙ୍କ ସମ୍ମାନ କରିବା ଆମର କର୍ତ୍ତବ୍ୟ।

D. ମା'–ବାପା ହେଉଛନ୍ତି ସନ୍ତାନଙ୍କ ଜୀବନର ଦିଗଦର୍ଶକ।

Question Type : MCQ
Question ID : 4410091485887
Option 1 ID : 4410095870014
Option 2 ID : 4410095870015
Option 3 ID : 4410095870016
Option 4 ID : 4410095870013

Status : Answered
Chosen Option : C

Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

ମା'–ବାପା ହେଉଛନ୍ତି ଆମ ଜୀବନର ପ୍ରଥମ ଶିକ୍ଷକ ଓ ଅଧ୍ୟାପକ। ସେମାନେ ଆମକୁ କେବଳ ଜନ୍ମ  ଦେଇନାହାନ୍ତି, ବରଂ ଆମକୁ
ଭଲ ମଣିଷ ହେବା ଶିଖାନ୍ତି। ମା' ଆମକୁ ସ୍ନେହ, ମମତା ଓ ସେବା ଦିଅନ୍ତି, ଯେବେକି ବାପା ଆମ ପାଇଁ  ସର୍ବଦା ପରିଶ୍ରମ କରନ୍ତି।

ଯେପରି ଗଛ ତାହାର ମୂଳ ଦ୍ୱାରା ଦୃଢ ହୁଏ, ତେଣୁ ଶିଶୁ ମା'–ବାପାଙ୍କ ଶିକ୍ଷା ଓ ଆଦର୍ଶ ଦ୍ୱାରା ସୁସଂସ୍କାରିତ ହୁଏ। ଯେ ଶିଶୁ
ମା'–ବାପାଙ୍କ କଥା ଶୁଣେ, ସେ ଜୀବନରେ ସଫଳ ହୁଏ। ଯେ ମା'–ବାପାଙ୍କୁ ସମ୍ମାନ କରେନି, ସେ ନିଜ ଜୀବନର ସତ୍ୟ
ମୂଲ୍ୟକୁ ହାରାଏ।

ମା'–ବାପା ଆମ ଜୀବନର ଦିଗଦର୍ଶକ ଓ ସହାୟକ। ସେମାନଙ୍କ ସନ୍ତୁଷ୍ଟି  ହେଉଛି ଆମ ସଫଳତା। ତେଣୁ ପ୍ରତ୍ୟେକ ସନ୍ତାନଙ୍କୁ
ମା'–ବାପାଙ୍କ ଶୁଶ୍ରୁ ଷା କରିବା ଓ ସେମାନଙ୍କ ଆଦେଶ ମାନିବା ଉଚିତ।

SubQuestion No : 77

Q.7
7

ଅନୁଚ୍ଛେଦର ମୁଖ୍ୟ ବିଷୟବସ୍ତୁକୁ ଚିହ୍ନଟ କର।

Ans A. ସନ୍ତାନଙ୍କ ଶିକ୍ଷାର ମୂଲ୍ୟ

B. ଗଛ ଓ ମୂଳର ସମ୍ପର୍କ

C. ମା'–ବାପାଙ୍କ ସେବା ଓ ଶିକ୍ଷାର ଗୁରୁ ତ୍ୱ

D. ଜୀବନର ସଫଳତା

Question Type : MCQ
Question ID : 4410091485888
Option 1 ID : 4410095870017
Option 2 ID : 4410095870019
Option 3 ID : 4410095870018
Option 4 ID : 4410095870020

Status : Answered
Chosen Option : C
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Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

ମା'–ବାପା ହେଉଛନ୍ତି ଆମ ଜୀବନର ପ୍ରଥମ ଶିକ୍ଷକ ଓ ଅଧ୍ୟାପକ। ସେମାନେ ଆମକୁ କେବଳ ଜନ୍ମ  ଦେଇନାହାନ୍ତି, ବରଂ ଆମକୁ
ଭଲ ମଣିଷ ହେବା ଶିଖାନ୍ତି। ମା' ଆମକୁ ସ୍ନେହ, ମମତା ଓ ସେବା ଦିଅନ୍ତି, ଯେବେକି ବାପା ଆମ ପାଇଁ  ସର୍ବଦା ପରିଶ୍ରମ କରନ୍ତି।

ଯେପରି ଗଛ ତାହାର ମୂଳ ଦ୍ୱାରା ଦୃଢ ହୁଏ, ତେଣୁ ଶିଶୁ ମା'–ବାପାଙ୍କ ଶିକ୍ଷା ଓ ଆଦର୍ଶ ଦ୍ୱାରା ସୁସଂସ୍କାରିତ ହୁଏ। ଯେ ଶିଶୁ
ମା'–ବାପାଙ୍କ କଥା ଶୁଣେ, ସେ ଜୀବନରେ ସଫଳ ହୁଏ। ଯେ ମା'–ବାପାଙ୍କୁ ସମ୍ମାନ କରେନି, ସେ ନିଜ ଜୀବନର ସତ୍ୟ
ମୂଲ୍ୟକୁ ହାରାଏ।

ମା'–ବାପା ଆମ ଜୀବନର ଦିଗଦର୍ଶକ ଓ ସହାୟକ। ସେମାନଙ୍କ ସନ୍ତୁଷ୍ଟି  ହେଉଛି ଆମ ସଫଳତା। ତେଣୁ ପ୍ରତ୍ୟେକ ସନ୍ତାନଙ୍କୁ
ମା'–ବାପାଙ୍କ ଶୁଶ୍ରୁ ଷା କରିବା ଓ ସେମାନଙ୍କ ଆଦେଶ ମାନିବା ଉଚିତ।

SubQuestion No : 78

Q.7
8

ଗଦ୍ୟାଂଶପାଇଁ  ଉପଯୁକ୍ତ ଶୀର୍ଷକ ଚିହ୍ନଟ କର।

Ans A. ସନ୍ତାନ ଓ ସମୟ

B. ଶିକ୍ଷାର ମାର୍ଗ

C. ଆମ ଜୀବନର ନାୟକ

D. ମା'–ବାପାଙ୍କ ଗୁରୁ ତ୍ୱ

Question Type : MCQ
Question ID : 4410091485889
Option 1 ID : 4410095870024
Option 2 ID : 4410095870023
Option 3 ID : 4410095870021
Option 4 ID : 4410095870022

Status : Answered
Chosen Option : D

Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

ମା'–ବାପା ହେଉଛନ୍ତି ଆମ ଜୀବନର ପ୍ରଥମ ଶିକ୍ଷକ ଓ ଅଧ୍ୟାପକ। ସେମାନେ ଆମକୁ କେବଳ ଜନ୍ମ  ଦେଇନାହାନ୍ତି, ବରଂ ଆମକୁ
ଭଲ ମଣିଷ ହେବା ଶିଖାନ୍ତି। ମା' ଆମକୁ ସ୍ନେହ, ମମତା ଓ ସେବା ଦିଅନ୍ତି, ଯେବେକି ବାପା ଆମ ପାଇଁ  ସର୍ବଦା ପରିଶ୍ରମ କରନ୍ତି।

ଯେପରି ଗଛ ତାହାର ମୂଳ ଦ୍ୱାରା ଦୃଢ ହୁଏ, ତେଣୁ ଶିଶୁ ମା'–ବାପାଙ୍କ ଶିକ୍ଷା ଓ ଆଦର୍ଶ ଦ୍ୱାରା ସୁସଂସ୍କାରିତ ହୁଏ। ଯେ ଶିଶୁ
ମା'–ବାପାଙ୍କ କଥା ଶୁଣେ, ସେ ଜୀବନରେ ସଫଳ ହୁଏ। ଯେ ମା'–ବାପାଙ୍କୁ ସମ୍ମାନ କରେନି, ସେ ନିଜ ଜୀବନର ସତ୍ୟ
ମୂଲ୍ୟକୁ ହାରାଏ।

ମା'–ବାପା ଆମ ଜୀବନର ଦିଗଦର୍ଶକ ଓ ସହାୟକ। ସେମାନଙ୍କ ସନ୍ତୁଷ୍ଟି  ହେଉଛି ଆମ ସଫଳତା। ତେଣୁ ପ୍ରତ୍ୟେକ ସନ୍ତାନଙ୍କୁ
ମା'–ବାପାଙ୍କ ଶୁଶ୍ରୁ ଷା କରିବା ଓ ସେମାନଙ୍କ ଆଦେଶ ମାନିବା ଉଚିତ।

SubQuestion No : 79

Q.7
9

ଅନ୍ୟାନ୍ୟ ଉଦାହରଣରେ “ସମ୍ମାନ” ଶବ୍ଦର ସଠିକ ବ୍ୟବହାର କର।

Ans A. ଆମେ ପୁସ୍ତକକୁ ସମ୍ମାନ କରିବା ଉଚିତ ନୁହେଁ ।

B. ଆମେ ଶିକ୍ଷକଙ୍କୁ ସମ୍ମାନ କରିବା ଉଚିତ।

C. ସମ୍ମାନ ଅର୍ଥ ହେଉଛି ରାଗ।

D. ସେ ଅଧି କ ପ୍ରେରଣାଦାୟକ ସେଓ ଖାଏ

Question Type : MCQ
Question ID : 4410091485890
Option 1 ID : 4410095870027
Option 2 ID : 4410095870025
Option 3 ID : 4410095870028
Option 4 ID : 4410095870026

Status : Answered
Chosen Option : B
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Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

ମା'–ବାପା ହେଉଛନ୍ତି ଆମ ଜୀବନର ପ୍ରଥମ ଶିକ୍ଷକ ଓ ଅଧ୍ୟାପକ। ସେମାନେ ଆମକୁ କେବଳ ଜନ୍ମ  ଦେଇନାହାନ୍ତି, ବରଂ ଆମକୁ
ଭଲ ମଣିଷ ହେବା ଶିଖାନ୍ତି। ମା' ଆମକୁ ସ୍ନେହ, ମମତା ଓ ସେବା ଦିଅନ୍ତି, ଯେବେକି ବାପା ଆମ ପାଇଁ  ସର୍ବଦା ପରିଶ୍ରମ କରନ୍ତି।

ଯେପରି ଗଛ ତାହାର ମୂଳ ଦ୍ୱାରା ଦୃଢ ହୁଏ, ତେଣୁ ଶିଶୁ ମା'–ବାପାଙ୍କ ଶିକ୍ଷା ଓ ଆଦର୍ଶ ଦ୍ୱାରା ସୁସଂସ୍କାରିତ ହୁଏ। ଯେ ଶିଶୁ
ମା'–ବାପାଙ୍କ କଥା ଶୁଣେ, ସେ ଜୀବନରେ ସଫଳ ହୁଏ। ଯେ ମା'–ବାପାଙ୍କୁ ସମ୍ମାନ କରେନି, ସେ ନିଜ ଜୀବନର ସତ୍ୟ
ମୂଲ୍ୟକୁ ହାରାଏ।

ମା'–ବାପା ଆମ ଜୀବନର ଦିଗଦର୍ଶକ ଓ ସହାୟକ। ସେମାନଙ୍କ ସନ୍ତୁଷ୍ଟି  ହେଉଛି ଆମ ସଫଳତା। ତେଣୁ ପ୍ରତ୍ୟେକ ସନ୍ତାନଙ୍କୁ
ମା'–ବାପାଙ୍କ ଶୁଶ୍ରୁ ଷା କରିବା ଓ ସେମାନଙ୍କ ଆଦେଶ ମାନିବା ଉଚିତ।

SubQuestion No : 80

Q.8
0

ସମାନାର୍ଥବୋଧକ ଶବ୍ଦ ଚିହ୍ଣ ଟ କର:-“ସେବା”

Ans A. ଦୁଃଖ

B. ସହାୟତା

C. ଅସନ୍ତୁଷ୍ଟି

D. ଆଲସ୍ୟ

Question Type : MCQ
Question ID : 4410091485891
Option 1 ID : 4410095870032
Option 2 ID : 4410095870029
Option 3 ID : 4410095870030
Option 4 ID : 4410095870031

Status : Answered
Chosen Option : B

Q.8
1

What is the short-cut key in order to undo immediately after deleting a row or column in
Microsoft Excel 2021?

Ans A. Ctrl + C

B. Ctrl + A

C. Ctrl + X

D. Ctrl + Z

Question Type : MCQ
Question ID : 4410091478488
Option 1 ID : 4410095841292
Option 2 ID : 4410095841291
Option 3 ID : 4410095841293
Option 4 ID : 4410095841294

Status : Answered
Chosen Option : D

Section : Computer
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Q.8
2

Which tool in Windows is primarily used for managing files and folders?

Ans A. Control Panel

B. Task Manager

C. Microsoft Edge

D. File Explorer

Question Type : MCQ
Question ID : 4410091450098
Option 1 ID : 4410095728900
Option 2 ID : 4410095728902
Option 3 ID : 4410095728903
Option 4 ID : 4410095728901

Status : Answered
Chosen Option : D

Q.8
3

What does a strong password help protect?

Ans A. Computer speed

B. Printer performance

C. Unauthorized access to systems and accounts

D. File compression

Question Type : MCQ
Question ID : 4410091448969
Option 1 ID : 4410095724342
Option 2 ID : 4410095724340
Option 3 ID : 4410095724341
Option 4 ID : 4410095724343

Status : Answered
Chosen Option : C

Q.8
4

What is the primary function of antivirus software?

Ans A. To enhance internet speed

B. To manage user accounts ​​​​​​

C. To improve hardware performance

D. To detect, remove, and prevent malware infections

Question Type : MCQ
Question ID : 4410091467417
Option 1 ID : 4410095797603
Option 2 ID : 4410095797606
Option 3 ID : 4410095797605
Option 4 ID : 4410095797604

Status : Answered
Chosen Option : D
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Q.8
5

In the context of Digital Financial Tool, match the following Methods in Column A with
their correct Descriptions in Column B:

Column A –
Payment Method Column B – Description

1. UPI (Unified Payments
Interface)

a) Allows instant transfer of money between bank accounts
through mobile applications.

2. AEPS (Aadhaar Enabled
Payment System)

b) Conducts banking transactions using Aadhaar-based
biometric verification.

3. USSD (*99# service) c) Provides simple banking facilities via mobile phones
without the need for internet access.

4. NEFT d) Processes electronic fund transfers in scheduled batches
instead of real-time.

Ans A. 1–c, 2–b, 3–a, 4–d

B. 1–d, 2–c, 3–b, 4–a

C. 1–a, 2–b, 3–c, 4–d

D. 1–b, 2–a, 3–c, 4–d

Question Type : MCQ
Question ID : 4410091477648
Option 1 ID : 4410095837959
Option 2 ID : 4410095837961
Option 3 ID : 4410095837960
Option 4 ID : 4410095837958

Status : Answered
Chosen Option : C

Q.8
6

Which command in MS Word 2021 selects all the content in a document?

Ans A. Ctrl + A

B. Ctrl + X

C. Ctrl + C

D. Ctrl + S

Question Type : MCQ
Question ID : 4410091417306
Option 1 ID : 4410095598160
Option 2 ID : 4410095598159
Option 3 ID : 4410095598162
Option 4 ID : 4410095598161

Status : Answered
Chosen Option : A
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Q.8
7

Memory in a computer is broadly classified into:

Ans A. Magnetic and Optical storage

B. Input and Output memory

C. Primary and Secondary memory

D. Internal and Optical memory

Question Type : MCQ
Question ID : 4410091444331
Option 1 ID : 4410095705943
Option 2 ID : 4410095705941
Option 3 ID : 4410095705944
Option 4 ID : 4410095705942

Status : Not Answered
Chosen Option : --

Q.8
8

Which control in Microsoft Word 2021 is used to choose the font type and font size for
selected text?

Ans A. Styles gallery on the Home tab

B. Page Setup group on the Layout tab

C. Font group on the Home tab

D. Paragraph group on the Home tab

Question Type : MCQ
Question ID : 4410091459311
Option 1 ID : 4410095765378
Option 2 ID : 4410095765377
Option 3 ID : 4410095765375
Option 4 ID : 4410095765376

Status : Answered
Chosen Option : C

Q.8
9

Microsoft PowerPoint 2021 ରେ ଏକ ପ୍ରେଜେଣ୍ଟେସନ ଫାଇଲ ଖୋଲିବା ସମୟରେ, କେଉଁ  ଡିଫଲ୍ଟ
ୱାର୍କସ୍ପେସ ଭିଉ ପ୍ରଦର୍ଶିତ ହୋଇଥାଏ, ଯାହା ଆପଣଙ୍କୁ ସ୍ଲାଇଡ୍ସ (Slides), ନୋଟ୍ସ  (Notes), ଏବଂ ସ୍ଲାଇଡ
ଆଉଟଲାଇନ (Slide Outline) କୁ ଏକସମୟରେ ଏଡିଟ କରିବାକୁ ସକ୍ଷମ କରିଥାଏ?

Ans A. ରିଡିଙ୍ଗ ଭିଉ (Reading View)

B. ଆଉଟଲାଇନ ଭିଉ (Outline View)

C. ନର୍ମାଲ ଭିଉ (Normal View)

D. ସ୍ଲାଇଡ ସର୍ଟର ଭିଉ (Slide Sorter View)

Question Type : MCQ
Question ID : 4410091435644
Option 1 ID : 4410095671091
Option 2 ID : 4410095671093
Option 3 ID : 4410095671092
Option 4 ID : 4410095671090

Status : Not Answered
Chosen Option : --
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Q.9
0

MS ୱାର୍ଡ 2021 ଭଳି ଏକ ୱାର୍ଡ ପ୍ରୋସେସରରେ, ଯଦି ଜଣେ ଛାତ୍ର ଏକ ସମ୍ପୂର୍ଣ୍ଣ ପାରାଗ୍ରାଫର ଟେକ୍ସଟକୁ ବାମ
ମାର୍ଜିନରୁ  ଭିତର (paragraph's text inward from the left margin) କୁ ସ୍ଥାନାନ୍ତର କରିବାକୁ ଚାହାଁ ନ୍ତି,
ତେବେ ସେମାନେ ପାରାଗ୍ରାଫ ଫର୍ମାଟିଂର କେଉଁ  ମୁଖ୍ୟ ବୈଶିଷ୍ଟ୍ୟ ବ୍ୟବହାର କରିବା ଉଚିତ?

Ans A. ଫଣ୍ଟ ଷ୍ଟାଇଲ (Font Style)

B. ଲାଇନ ସ୍ପେସିଙ୍ଗ (Line Spacing)

C. ଇନଡେଣ୍ଟେସନ (Indentation)

D. ଟେକ୍ସଟ ଆଲାଇନମେଣ୍ଟ (Text Alignment)

Question Type : MCQ
Question ID : 4410091421778
Option 1 ID : 4410095616009
Option 2 ID : 4410095616008
Option 3 ID : 4410095616010
Option 4 ID : 4410095616011

Status : Answered
Chosen Option : D

Q.9
1

Which option helps organize files by size or type in File Explorer?

Ans A. Group by

B. Categorize

C. Sort by

D. Arrange by

Question Type : MCQ
Question ID : 4410091408299
Option 1 ID : 4410095562153
Option 2 ID : 4410095562156
Option 3 ID : 4410095562155
Option 4 ID : 4410095562154

Status : Answered
Chosen Option : C

Q.9
2

Which of the following media can be used to connect devices in a LAN?

Ans A. Satellite link, microwave link

B. Infrared signals only

C. Fiber optics, Ethernet cables, Wi-Fi

D. Telephone lines only

Question Type : MCQ
Question ID : 4410091462402
Option 1 ID : 4410095777718
Option 2 ID : 4410095777720
Option 3 ID : 4410095777721
Option 4 ID : 4410095777719

Status : Not Answered
Chosen Option : --
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Q.9
3

What is the primary function of the Insert (Ins) key in most text editors?

Ans A. Deletes the current line

B. Opens the clipboard history

C. Moves the cursor to the beginning of the line

D. Toggles between insert and overwrite mode

Question Type : MCQ
Question ID : 4410091445403
Option 1 ID : 4410095710193
Option 2 ID : 4410095710196
Option 3 ID : 4410095710195
Option 4 ID : 4410095710194

Status : Not Answered
Chosen Option : --

Q.9
4

Which sequence correctly opens the dialog box to type an exact column width in
Excel?

Ans A. Data → Text to Columns → Column Width

B. Insert → Column → Width → Type value

C. Home → Cells → Format → Column Width

D. View → Freeze Panes → Column Width

Question Type : MCQ
Question ID : 4410091452321
Option 1 ID : 4410095737678
Option 2 ID : 4410095737676
Option 3 ID : 4410095737679
Option 4 ID : 4410095737677

Status : Not Answered
Chosen Option : --
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Q.9
5

Match the following Saving Options (Column A) with their corresponding
Descriptions (Column B) as used in Microsoft PowerPoint 2021:

Column A – Saving
Option / Command Column B – Description

1. Ctrl + S a) Opens the dialog box to save the presentation with
a new name or in a different format.

2. File → Save As b) Automatically saves the presentation to the same
location with recent changes.

3. AutoRecover c) Recovers unsaved presentations after an
unexpected shutdown.

4. F12 Key d) Shortcut key for opening the “Save As” dialog box.

Ans A. 1–b, 2–d, 3–a, 4–c

B. 1–d, 2–c, 3–a, 4–b

C. 1–b, 2–a, 3–c, 4–d

D. 1–a, 2–b, 3–d, 4–c

Question Type : MCQ
Question ID : 4410091478013
Option 1 ID : 4410095839386
Option 2 ID : 4410095839385
Option 3 ID : 4410095839383
Option 4 ID : 4410095839384

Status : Answered
Chosen Option : C

Q.9
6

Which network facility is spread over a relatively small geographical radius?

Ans A. SAN

B. LAN

C. WAN

D. MAN

Question Type : MCQ
Question ID : 4410091447972
Option 1 ID : 4410095720381
Option 2 ID : 4410095720383
Option 3 ID : 4410095720382
Option 4 ID : 4410095720380

Status : Not Answered
Chosen Option : --
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Q.9
7

When inserting a video into MS Powerpoint Presentation from your computer using
Insert → Video, which of the following is true about playback behavior?

Ans A. The video always plays only when you click the play button; there is no automatic start
option

B. The video cannot be trimmed after insertion

C. If you use the Recording tab → Video insertion option (in MS-PowerPoint 2016+), the
video will auto-play by default when the slide appears.

D. The video will only play if the file is online (cloud) and not local.

Question Type : MCQ
Question ID : 4410091456177
Option 1 ID : 4410095753054
Option 2 ID : 4410095753055
Option 3 ID : 4410095753056
Option 4 ID : 4410095753057

Status : Answered
Chosen Option : A

Q.9
8

Which of the following statements accurately explains the relationship between the
Control Unit (CU) and the Arithmetic Logic Unit (ALU) during instruction processing?

Ans A. The CU decodes instructions and signals the ALU to execute arithmetic or logical
operations.

B. The ALU fetches instructions from memory and sends them to the CU for decoding.

C. The ALU controls the flow of data and manages all input and output devices.

D. The CU performs arithmetic operations while the ALU stores intermediate results.

Question Type : MCQ
Question ID : 4410091446640
Option 1 ID : 4410095715223
Option 2 ID : 4410095715222
Option 3 ID : 4410095715224
Option 4 ID : 4410095715225

Status : Not Answered
Chosen Option : --

Q.9
9

What happens in MS Excel if you type 'Monday' in a cell and drag the fill handle
downward?

Ans A. It shows an error popup.

B. It repeats 'Monday' in all cells.

C. It creates: Monday, Tuesday, Wednesday...

D. It creates a date series.

Question Type : MCQ
Question ID : 441009910201
Option 1 ID : 4410093594950
Option 2 ID : 4410093594947
Option 3 ID : 4410093594948
Option 4 ID : 4410093594949

Status : Answered
Chosen Option : C
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Q.1
00

What is the full form of GPU ?

Ans A. General Processing Unit

B. General Purpose Unit

C. Graphical Purpose Unit

D. Graphics Processing Unit

Question Type : MCQ
Question ID : 4410091475548
Option 1 ID : 4410095829518
Option 2 ID : 4410095829520
Option 3 ID : 4410095829521
Option 4 ID : 4410095829519

Status : Answered
Chosen Option : D
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